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Clinical FAQ’s Webinar [3.9.2022] 

Q1: Why do I sometimes receive recalculation warnings on my MDS 
transmission file report I receive from the QIES ASAP system? 
When you transmit your MDS batch files to the QIES ASAP system, you will receive a validation 
report.  On this report, you will see either an Accepted or Rejected.  Sometimes however, you 
will see Accepted, but also what we refer to as recalculation warnings.  These warnings will 
occur when ECS and CMS are calculating different PDPM HIPPS codes or if they are 
calculating using different logic versions.     
 

 
No matter what the case, they are warnings, not rejections, so you should not resubmit the 
MDS assessment to them.  They have received it and accepted it but are making you aware to 
a potential issue within the software or with the PDPM HIPPS code that was calculated.   
 
If you receive this warning due to a different version, then one of the following would be the 
cause: 

1. CMS released the updated PDPM grouper recently and it has not yet been 
programmed into ECS; or 

2. The version of ECS you are using is not the most up to date (to include the updated 
PDPM grouper version); or 

3. Your version of ECS is updated, however the assessment that was transmitted to the 
QIES system had HIPPS calculated prior to updating. 

If you receive this warning due to a recalculated PDPM HIPPS code and you notice that the 
one listed on the validation report differs from what ECS has calculated, you should follow the 
below steps: 

1. Try to recalculate the HIPPS on the assessment.  Maybe an item was changed on the 
MDS and was not resubmitted after that change or ECS was updated after you 
calculated the HIPPS. 

2. If the HIPPS still do not match what CMS calculated, then you should contact the 
clinical department so we may further investigate the cause.   

Q2: When does American Data release new updates?  And how will I 
know when a new update has been released? 
We try to release two large updates each year to correlate with when CMS releases their 
updates to the MDS.  We aim for one update in the spring and one in the fall.  All updates 
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released in between are considered “patches” and are released with the intention of 
correcting any known issues.  However, our two larger updates each year is when we plan for 
most of our enhancements.   
 
When these updates are applied to your facility’s ECS database will depend on whether you 
are hosted by American Data or not. If hosted by American Data, we apply windows updates, 
ECS updates, etc. once a month. Currently this is being completed on the third Tuesday of the 
month with outage expected from 10pm-11pm CST.  If your facility hosts your own servers, 
then your IT department may apply the updates whenever they would like.   
 
To notify facilities that updates are available, we post on our ECS User’s Forum, and we also 
send an email out to all clients who have opted in for update related emails.  Our ECS User’s 
Forum is located on our Client Sign On page.  Access to this site is managed internally by your 
facility.  If you are unsure who manages these user accounts, you may contact the clinical or 
marketing department and we can assist you. If you are not receiving update emails, but 
would like too, you can email cares@american-data.com and ask to receive update emails.  
We do typically post the update to the site for a few days and let it “soak” before sending the 
email.  If you want to be an early adopter of latest versions, keep a close eye on our ECS User’s 
Forum as we post in there soon after an update is released.     

Q3: How do I complete an MDS assessment for purpose of Medicare 
Replacement or Insurance billing? 
If you need to complete a Medicare Replacement or Insurance billing assessment, there are a 
few things to consider.  Would this be a stand-alone assessment?  Or do you also need an 
OBRA, or discharge tracking assessment completed as well?  If so, then there may be an 
instance where these assessments can be combined.   
 
If you are in the state of WI, Medicare Replacement, and Insurance billing MDS assessments 
can no longer be combined, unless you are completing a discharge tracking and PPS 
discharge.  This means that you will need to complete a stand-alone PPS for Medicare 
Replacement and the OBRA also as a stand-alone assessment.  If you are not in the state of WI, 
you may continue to combine these assessments.   
 
On the Type of Assessment/Tracking 
screen, place the dot in OBRA and/or PPS 
or OSA Assessment.   
 
On the next screen, Assessment Coding, 
you will code for the type of MDS needed, 
but will also place a check mark into For 
Medicare Replacement or Insurance Billing. 
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Once the assessment is coded and this check mark is in place, the dot in Transmit or Do Not 
Transmit will automatically populate based on the choices selected.  For example, if a stand-
alone Admission assessment is selected, then the checkbox for Medicare Replacement will not 
even be open as it’s not relevant.  However, if a user selects an OBRA and PPS assessment 
type, then the system will determine that because a portion of the assessment needs to be 
transmitted, the dot should remain in Transmit.  If a stand-alone PPS is being complete for 
purposes of Medicare Replacement, then the dot will switch to Do Not Transmit.   
 
Keep in mind that any portion of the MDS which is related solely to the PPS assessment for 
purpose of Medicare Replacement will not display in the transmission file sent to QIES ASAP.  
If you combine a Discharge RA with a PPS Discharge, only the Discharge RA will send to CMS 
and the PPS Discharge will remain hidden.   

Q4: If a user changes their name, has a title change, or changes position 
within the facility, what is the process for updating their user information 
in ECS? 
Everything documented in ECS is tied to a user’s login and is considered a legally binding 
signature.  However, there is no effective date when changes such as a person’s title or name 
occurs.  This means that if someone starts at a facility as a CNA and at some point, receives 
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their LPN or RN, or a person gets married or changes their name for any reason; then the 
appropriate steps need to be taken to ensure that ECS remains accurate.  Do not simply 
update the information listed in their existing user properties to reflect the changes.  Instead, 
you will want to create a new user.  However, because users typically like to keep their same 
login name and those cannot be duplicated in ECS, we recommend following the steps 
below. 

1. In their original user (with the now incorrect credentials, name, etc.), add a “2” behind 
the login name.   

2. Create a new user with the original login name as well as a temporary password.  Place 
a checkmark in User must change password at next login to allow for the user to create 
their own password.     

3. Once you have confirmed that the user has logged in with the new user account 
created, then you will want to inactivate the legacy account.  This will not remove any 
documentation but will rather just move the username out of the active user list. 

Q5: Do you run updates to ECS for our facility? 
The answer to this question depends on whether your facility hosts ECS on your own servers 
or within the cloud or if you host with American Data.   
 
If hosted by American Data, ECS updates occur once a month.  Currently this is being 
completed on the third Tuesday of the month with outage expected from 10pm-11pm CST.  If 
your facility hosts your own servers, then your IT department may apply the updates whenever 
they would like.   

Q6: Why are my 672/802 Survey Reports not showing the most updated 
information? 
The 672/802 Survey Reports are not setup to automatically refresh when they are opened.  
This is because they are both an ever-changing document that may require manual updates as 
well.  If a facility would like either report to update based on newly 
submitted MDS assessments or documentation from the record, clicking 
the Refresh button will complete this task.   
 
We recommend clicking onto Refresh first before making any necessary 
manual updates.  When Refresh is clicked onto, if there is an MDS 
assessment or documentation with a more recent date than what is 
currently saved in a cell, then this cell will be overridden with the 
information in the record.  Utilize the Workspace Editor to determine 
what may have been in a cell before the refresh was completed vs. what 
is being suggested now.   
 
In the example here, we can see that the previous data that was saved is 
that this cell was blank (no data), but now based on an MDS from 
5/13/2020, it is being suggested that we should have this column 
checked.  If we are ever unsure of the data that is being suggested, we 
can utilize the Show Source button.  This will bring you to the 
documentation or the MDS.   
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Q7: Is there an easy way to access the RAI manual while completing an 
MDS assessment? 
Yes!  The RAI Manual can be easily accessed as you are completing an MDS assessment.  Click 
onto a question in the MDS that you need more information in and click onto the question 
mark symbol in the upper right-hand corner.   

 

Q8: If I see a new feature after an update, how do I learn about it? 
All new features are described in detail via our 
Smartsheet link.  This is a program that we 
utilize to describe outstanding issues as well as 
educate on new features.  The link changes 
with each large update/version.  The link to the 
Smartsheet is included in our update emails as 
well as posted in the ECS User’s Forum 
(accessed from our Client Sign On).   
 
Once you have accessed the Smartsheet, it will 
by default load via the “Card View” which 
means each new feature will be outlined within 
its own card.  To learn more about a feature, 
and to see any items attached to the new 
feature, double click onto a card.  This will 
provide additional details regarding how to 
utilize the feature, as well as a preview as to what it may look like. 
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Q9: How do I change my initials in ECS? 
If the initials for a user were entered incorrectly, then someone in our technical department 
can assist in changing them.  However, if the initials are incorrect as the user has changed their 
name, follow the steps listed in Q4 above.   

Q10: How do I access the training materials and videos? 
All training documentation, past webinars, future webinar signup, and training videos are 
located on our Client Sign On.  This is accessed via our website at https://www.american-
data.com/.  Then click onto the Client Sign On button in the upper right-hand corner.  Enter in 
your credentials (these are provided and managed by the Client Sign On Administrator at 
your facility).  The credentials for logging into the site may not match the credentials you use 
to access ECS.  The credentials for ECS and the Client Sign On are managed separately, but 
both are managed by someone internally at your facility and are not managed by American 
Data.  If you are unsure who the Client Sign On Administrator at your facility is, we can provide 
that information.   

Q11: How do I get the progress wheels back onto the MAR/TAR?   
In version 10.1.6.0, we released a popular feature, progress wheels on the MARs/TARs.  
However, this had a negative impact on some facilities or within certain types of MAR/TAR 
tasks.  Although not all facilities were affected, we wanted to ensure that we did not cause any 
unintended consequences for users who were utilizing this feature, so we decided to revert 
the change until a later date when an appropriate solution could be determined.   
 
That solution came out in version 10.1.6.5 in the form of a check box on the electronic sign 
setup.  This allows a facility to choose whether they want the progress wheels on the MAR/TAR 
and even allows for that to occur per task type.  This means that if some tasks make sense to 
have the wheels, whereas others do not, the user can easily add the checkbox onto only the 
tasks where the progress wheels are necessary.  To enable the progress wheels, follow the 
steps below. 

1. Click onto the Toolbar. 
2. Click onto the Sign icon (or navigate via American Data – ECS > Write > Sign > 

Electronic Sign). 
3. Click onto Tasks.  
4. Highlight a task that you want to add the progress wheels too and click onto Edit. 
5. Place a checkmark in Show Progress Wheels. 
6. Click OK to save changes. 
7. Complete the above steps for each task requiring progress wheels. 
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Q12: How do I see NTA points associated with a PDPM HIPPS Code? 
There are a couple of ways to view the NTA points.  One is within the MDS assessment itself, 
so would be on a per resident basis.  The other is within MDS Analytics so that you can see 
more than one resident at a time.  If wanting to view the NTA points within an MDS, once you 
have calculated the HIPPS codes, highlight the PDPM score and click onto Explain.  This will 
load the PDPM Score Calculation Explanation of Results page.  If you scroll to the bottom, you 
will see the NTA Component listed, with the HIPPS character, as well as the score. 
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To view the NTA points on more than one resident at a time, you will want to utilize the MDS 
Analytics.  Follow the steps below to run the NTA report. 

1. The MDS Analytics report screen can be accessed one of three ways: 
a. MDS Manager 
b. Easy access button 
c. American Data – ECS > View > Report > MDS Analytics 

2. Once in the MDS Analytics screen, utilize the Select Report drop-down to select the 
NTA Points (PDPM) report.   

3. Select an option from the Site/Service dropdown. 
4. Enter in Date From and Date To.   
5. Uncheck any options, if needed. 
6. Click onto Print or Export.   

 

Q13: Can I look up why I received a PDPM HIPPS code on a resident? 
To view why you are receiving a specific PDPM HIPPS code, you will want to click onto the 
Explain button from within the HIPPS Code Calculations screen.  Once you have calculated the 
HIPPS codes, highlight the PDPM score and click onto Explain.  This will load the PDPM Score 
Calculation Explanation of Results page. 
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Q14: Is there a way to view more than one screen at a time?   
ECS is like a web browser window in that as you click into a screen, a new tab is opened. 
 

 
This allows for multiple reports, documenting screens, view tasks, etc. to be open at one time.  
You may click through the different tabs to navigate to open items.  However, there are times 
when it may be useful to tile a couple of these items side by side.  To do, you can utilize the 
Tile Side by Side or Tile Top and Bottom.  For this to work, you will have to close all the tabs 
except for the ones you would like tiled.  The tiling feature typically works best when there are 
only two tabs being tiled.  Even your Easy screen will have to be closed out for this to work.   
 
For example, if I want to tile an MDS next to the 672 report, I need to make sure that the 
Toolbar and only the two tabs to tile are open.   

 
I will then click onto American Data – ECS > Window > Tile Side by Side.  This will tile each tab 
next to one another.  If I close out of either or open a new one, the tiling will cease.  When 
needing to get back to the easy access screen, click onto Toolbar > Easy.  This will launch your 
easy screen.    

Q15: How do I know when American Data builds new setups or 
modules?  Where can I learn more about what is available? 
When new features become available, there are a few different areas that we promote these.   

1. Our newsletter 
2. Client Sign On > ECS User’s Forum > New and Notable Items in ECS discussion thread 
3. Webinars 

When new modules are developed within our default database, these setups cannot be 
automatically sent into all ECS databases as we have so many different configurations and 
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uses of ECS (i.e., adult daycare, nursing homes, jails, etc.)  Because of this, all new modules are 
available to our clients on a request basis.  Meaning that if you are interested in getting a 
module setup in your facility’s ECS, you will want to send an email to clinical@american-
data.com to request it and approve of any billable time.  You may also email us to request an 
estimate for receiving a module.  The most recently developed features consist of: 

1. COVID-19 Staff Matrix topic and report 
2. ASQ Suicide Risk Screening Tool 
3. ASQ Brief Suicide Safety Assessment 
4. P4 Suicidality Screener 
5. Dedicated access screen for Restorative Aides 

The following feature is in development to be released next: 
1. Survey readiness topic with new reports 

Q16: How do I increase a user’s font size?  Can this be done system 
wide? 
There is not a way to increase the font size system wide or for all users at once.  It is a user-by-
user setup.   
 

1. Navigate to American Data – ECS > Setup > Security > User.   
2. Double click into a username to access the Properties screen. 
3. On the Options tab, place a check mark in Enlarge Menus and enter a number into the 

Size box (we don’t recommend going any larger than 12, the default font size is 8).   
4. In addition, click onto the “F” button, which is what will adjust the font size in the 

eMAR/eTAR only.  Adjust the font, style, and size here.   
5. Click OK to save changes. 


